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					ABSTRACT  

					ARTICLE INFO  

					12-Methoxy-4-Methylvoachalotine (MMV) is a sarpagine indole alkaloid isolated from  

					Tabernaemontana macrocarpa and has been implicated in the treatment of tumors and as an anti-  

					snake venom. This study aims to explore MMV as an anticancer agent using in silico methods.  

					The research integrates network pharmacology to identify key protein targets associated with  

					MMV and molecular docking to evaluate the binding affinity and interaction profile of MMV with  

					selected proteins implicated in anticancer mechanisms. The pharmacological network analysis  

					identified ten key targets, including PTEN, HIF1A, CCND1, ESR1, AKT1, MTOR, MCL1,  

					EGFR, and ERBB2, which are closely related to the mechanism of cell proliferation and apoptosis  

					regulation. MMV molecular docking results against the five proteins (TP53, PTEN, ESR1, EGFR,  

					and MCL1) showed lower binding affinity than the native ligands; however, the interaction  

					patterns closely resemble those of the reference ligands. Absorption, distribution, metabolism,  

					excretion, and toxicity (ADMET) predictions indicated low solubility but high gastrointestinal  

					absorption potential. These findings provide important insights into the potential of MMV as an  

					anticancer agent and emphasize the need for structural modifications to enhance its therapeutic  

					efficacy.  
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					An in silico approach is often used as an initial step to guide and  

					streamline experimental research by leveraging biological databases  

					and software.8 This technique provides an efficient preliminary method  

					Introduction  

					Cancer remains a global health problem, with an estimated  

					19.98 million new cases and 9.74 million cancer-related deaths reported  

					in 2022.1 According to data from the Global Cancer Observatory  

					(GLOBOCAN), in Indonesia, there were 408,661 new cases of cancer,  

					underscoring the urgent need for improved prevention and treatment  

					strategies.2 The main challenge in cancer treatment is drug resistance,  

					often associated with the extensive use of synthetic chemotherapeutic  

					agents, which also exhibit severe side effects.3 Therefore, research into  

					new compounds that are safer and more effective is fundamental. 12-  

					Methoxy-4-Methylvoachalotine (MMV), an indole alkaloid isolated  

					from Tabernaemontana macrocarpa,4 has been reported to exhibit  

					biological activity, including the inhibition of snake venom  

					phospholipase A2-like protein5 and antifungal activity against  

					Trichophyton rubrum.6 Preliminary studies by Pereira et al.7 suggest  

					MMV’s anticancer potential; however, its precise mechanism of action  

					and interaction with target proteins remain unexplored.  

					for evaluating bioactive compounds, leveraging computational models  

					to predict pharmacological interactions.8 Network pharmacology  

					facilitates the identification of drug-target interactions within complex  

					biological systems,9 while molecular docking assesses ligand-receptor  

					interactions at the atomic level, enabling the evaluation of potential  

					binding affinities and structural compatibility.10 In this study, the  

					selected cancer-related MMV receptor targets will be analyzed using  

					the molecular docking method to ensure that MMV can interact with  

					the target receptor.  

					Materials and Methods  

					Materials  

					Computational analyses were conducted on an Acer Aspire A314-22  

					laptop using the following software tools: PLANTS, YASARA,  

					MarvinSketch, CMD, Ligplus, Cytoscape 3.10.1 with the CytoHubba  

					0.1 plugin, and pkCSM. This study also utilized several online  
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					databases  

					and  

					web  

					servers,  

					including  

					PubChem  

					(https://pubchem.ncbi.nlm.nih.gov/),  

					(http://swisstargetprediction.ch/),  

					SwissTargetPrediction  

					GeneCards  

					Citation: Amelia P, Hefni D, Frengki F, Azriftria, Dinda M, Wahyuni FS,  

					Dachriyanus, Nugroho AE, Hirasawa Y, Morita H. Network Pharmacology  

					and Molecular Docking Study of 12-Methoxy-4- Methylvoachalotine  

					(MMV) as an Anticancer Agent. Trop J Nat Prod Res. 2025; 9(11): 5638 –  

					5648 https://doi.org/10.26538/tjnpr/v9i11.51  

					(https://www.genecards.org/), and STRING (https://string-db.org/).  

					Meanwhile, the materials used in this study include the SMILES  

					structure, 2D and 3D structures of 12–Methoxy–4–Methylvoachalotine  

					(MMV), and the 3D structures of the target proteins: 1A52, 1D5R,  

					5A7B, 6TFU, and 6NE5.  

					Official Journal of Natural Product Research Group, Faculty of Pharmacy,  

					University of Benin, Benin City, Nigeria  

					Networking of Pharmacology Analysis  

					The SMILES code for 12–Methoxy–4–Methylvoachalotine (MMV)  

					was obtained from PubChem11 and entered into SwissTargetPrediction  

					to identify its target protein.12 All MVW target proteins with probability  
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					values >0 were processed into STRING13 to determine the  

					pharmacological network between proteins predicted to be able to  

					interact with the MMV compound. The STRING data were analyzed  

					using Gene Ontology (GO) and Kyoto Encyclopedia of Genes and  

					Genomes (KEGG) enrichment analyses. In addition, the data were also  

					imported into Cytoscape,14 and the most important proteins in this  

					network were searched for using the CytoHubba plugin.15  

					ADMET Prediction of Ligand Test  

					The Canonical SMILES of the MMV prepared in MarvinSketch were used  

					for ADMET testing using pkCSM. pkCSM was accessed at  

					https://biosig.lab.uq.edu.au/pkcsm/.  

					the necessary ADMET parameters —such as absorption, distribution,  

					The smiles were entered, and  

					metabolism, excretion, and toxicity —were selected.  

					Results and Discussion  

					Molecular Docking Analysis  

					The analysis identified 98 proteins predicted to interact with MMV  

					compounds targeting cancer, and then proceeded with pharmacological  

					network analysis using STRING. This analysis was carried out to  

					construct a network linking selected target proteins and the biological  

					pathways associated with them (Figure 1).17 STRING is a database  

					containing more than 9 million proteins from various sources that can  

					be used to predict protein interactions.18 The results of the  

					pharmacological network analysis of STRING were further analyzed  

					using GO Biological Process and KEGG enrichment (Figures 2 and 3).  

					Protein Selection  

					Protein structures were downloaded from the Protein Data Bank  

					(http://rscb.org/) in .pdb format. The method used to determine the  

					macromolecular structure is X-ray crystallography, which is suitable for  

					large macromolecules and provides high-resolution data (RMSD < 3.5  

					Å) for the human organism (Homo sapiens).16 Files were stored in the  

					D:\VALIDATION folder. The selection of proteins was based on their  

					relevance in signaling pathways that regulate cell growth, proliferation,  

					and apoptosis, which are essential in cancer. The protein structures used  

					have been determined experimentally, allowing analysis of the  

					interaction between MMV compounds and target proteins.  

					Docking Validation Protocol  

					The first step after protein selection is to prepare the protein and the  

					ref_ligand using YASARA. The target protein structure was  

					downloaded from http://rscb.org/ in .pdb format and saved in the  

					D:\VALIDATION folder. The protein file was then opened using  

					YASARA via the File > Load > PDB file menu. Water molecules were  

					removed, hydrogen atoms were added via the Edit > Add > Hydrogen  

					to all menu, and the result was saved in YASARA Object (.yob) format.  

					Next, the ligand present in the protein was removed, and the file was  

					saved as protein.mol2. To prepare the ref_ligand, the .yob file was  

					reopened, the protein was removed, and the result was saved as  

					ref_ligand.mol2. The ligand was then opened in MarvinSketch for a  

					clean 2D view, protonated at pH 7.4, and saved as ligand_2D.mrv. The  

					ligand conformation was identified via the Tools > Conformation >  

					Conformers menu, with 10 conformers, and then saved as ligand.mol2.  

					The docking process was performed by opening cmd.exe and typing the  

					command: PLANTS --mode bind ref_ligand.mol2 5 protein.mol2. The  

					center coordinates and radius were recorded, then these values were  

					inserted into the pc_4pyp.txt file and saved as pc_pdbid.txt. Next, the  

					PLANTS --mode screen pc_pdbid.txt command is executed. After the  

					process was complete, the lowest docking score was obtained by typing  

					the command "more bestranking.csv". The RMSD calculation was  

					performed by removing hydrogen atoms and comparing the docked  

					ligand conformation with the reference ligand using YASARA. If the  

					RMSD is below 2Å, the docking protocol is considered valid. The  

					RMSD calculation results were saved as PDBID.sce in the  

					D:\VALIDASI PDBID folder, concluding the validation process.  

					Molecular Docking of Ligand Test  

					The preparation stage of the test ligand begins by creating a folder  

					named MMV_PDBID and copying important files, such as cmd.exe,  

					PLANTS.exe, and the protein.mol2 into it. The molecular structure of  

					MMV was drawn in MarvinSketch, protonated at pH 7.4, and saved as  

					MMV_2D.mrv. After that, the conformation was searched using  

					Tools > Conformation > Conformers, set to 10, and saved as  

					MMV.mol2. For molecular docking, the cmd.exe file was opened.  

					Plants –mode bind ref_ligand.mol2 5 protein.mol2 was input, and for  

					screening, plants --mode screen pc_pdbid.txt was entered. After the  

					process was complete, the cd results were viewed in the results folder,  

					and the SCORE_RB_PEN column was used to sort the docking results  

					in best-ranking.csv. For visualization, a PDB file from the YASARA  

					docking results was generated by loading the protein.mol2, merging it  

					with the ligand, and saving it as MMV_PDBID.pdb. It was opened in  

					Discovery Studio to display the 2D diagram, and a screenshot was taken  

					and saved as a JPEG. This step was repeated with the native ligand,  

					saved as ref_ligand_PDBID.pdb, and Discovery Studio was finally  

					closed after all visualizations were complete.  

					Figure 1: Pharmacological Network Model of 98 proteins  

					targeted by the compound 12-Methoxy-4-Methylvoachalotine  

					(MMV)  

					The results of this analysis are based on the False Discovery Rate  

					(FDR), which is the expected proportion of false positives among the  

					data points that are rejected. So the smaller the FDR value, the more  

					accurate the analysis results are.19 FDR is expressed in the form of -Log  

					(p values); the greater the value, the lower the possibility of error.  

					Pharmacological networks are becoming  

					a

					viable method for  

					accelerating the discovery of new drugs and clarifying how drugs act  

					on different targets. Pharmacological networks describe diseases as  

					disorders of complex biological networks and use computational  

					methods to infer how drugs act from network topology.20 In recent  

					years, the emergence of pharmacological network methods has been  

					able to define complex interactions between active compounds, targets,  

					pathways, and related diseases, thus providing more scientific and  

					efficient research ideas and methods for predicting active compounds  

					in plants.21 Several approaches can be used to analyze pharmacological  

					5639  

					© 2025 the authors. This work is licensed under the Creative Commons Attribution 4.0 International License  

				

			

		

		
			
				
					
				
			

			
				
					Trop J Nat Prod Res, November 2025; 9(11): 5638 - 5647  

					ISSN 2616-0684 (Print)  

					ISSN 2616-0692 (Electronic)  

					networks, including GO and KEGG enrichment. GO enrichment is a  

					tool for identifying biological mechanisms from a collection of genes  

					or proteins derived from research data. There are three terms in GO:  

					biological process (BP), molecular function (MF), and chemical  

					component (CC).22 KEGG (Kyoto Encyclopedia of Genes and  

					Genomes) enrichment is a collection of manually curated biological  

					signaling pathways that represent knowledge of molecular interaction  

					and reaction networks.23 From the results of GO enrichment (Figure 2)  

					the pharmacological network of MMV compounds is predicted to be  

					potentially involved in several biological process mechanisms such as  

					pathways in cancer (Pancreatic cancer, Gastric cancer, Colorectal  

					cancer, Lung cancer, etc.), biological processes related to virus therapy  

					(Hepatitis B, Herpe virus, Epstein- Bar virus, etc.), also related to  

					biological processes related to metabolic disorders (Endocrine  

					resistance and Insulin resistance).  

					Figure 3: View of multiple MMV compound targets as  

					anticancer in the “pancreatic cancer pathway”  

					TP53 is the most influential protein in this pharmacological network.  

					P53 is known as "the guardian of the genome" because it controls the  

					cell cycle, triggers apoptosis, and senescence.28 Thus, this protein is  

					essential for use and has been proven as a target for research on MMV  

					compounds as an anticancer.  

					Several articles have used pharmacological networks to explain the  

					mechanisms by which plant secondary metabolites act as anticancer  

					agents. The Physalis angulata (L.) plant is predicted to suppress  

					proliferation, inhibit metastasis, and trigger apoptosis in lung cancer,  

					based on the Maximal Clique Centrality (MCC) CytoHubba analysis. A  

					total of 10 most important genes (CDKN2A, KRAS, RBB2, PTEN,  

					KRAS, NRAS, EGF, NFI, BRAF, and TP53) in the 3 anticancer  

					mechanisms have also been used in the pharmacological network  

					method in analyzing the role of secondary metabolites of the F.  

					sargassaceae plant as anticancer in oral squamous cell carcinoma  

					(OSCC). 29-30  

					Figure 2: GO Biological Process and KEGG enrichment  

					analysis. The X-axis shows the level of prediction accuracy,  

					the Y-axis shows the type of Enrichment result, the color of the  

					circle shows the greener the color, the more genes/proteins in  

					the Enrichment type are involved, and the size of the circle  

					shows the total number of genes/proteins in the Enrichment  

					type.  

					The results of the KEGG enrichment analysis (Figure 3) in pancreatic  

					cancer show that MMV compounds interact with proteins involved in  

					apoptosis activity through the PI3K-Akt signaling pathway and the  

					MAPK signaling pathway. Likewise, it is involved in proteins related  

					to the cell cycle through the Jak-STAT, p53, and TGF-β signaling  

					pathways. The PI3K-Akt and MAPK signaling pathways not only play  

					important roles in regulating cell proliferation but are also involved in  

					the mechanism of apoptosis.24 The Jak-STAT signaling pathway is  

					widely reported to be involved in promoting cell proliferation,  

					angiogenesis, invasion, and chemotherapy resistance.25 Activation of  

					p53 is even more complex in its role in maintaining genomic balance,  

					such as antiangiogenic mechanisms, triggering apoptosis, DNA repair,  

					regulating metabolism, and cell cycle arrest.26 Meanwhile, Jak-STAT is  

					reported to be involved in the mechanisms of regulating cell  

					proliferation and apoptosis.27  

					Furthermore, the analysis of essential proteins in the cancer network  

					was conducted using the MCC (Maximal Clique Centrality) algorithm  

					via the CytoHubba plugin in Cytoscape.15 The results of this analysis  

					are the top 10 proteins that have the most roles in the pharmacological  

					network related to cancer (Figure 4). From the results of the analysis, it  

					was found that the protein gene with the darkest intensity (TP53) (red)  

					shows the most influential gene in this network. Furthermore, the  

					brighter it is, the lower its influence (sequentially including the PTEN,  

					HIF1A, CCND1, ESR1, AKT1, MTOR, MCL1, EGFR, and ERBB2  

					genes). The assessment of the most influential genes/proteins is based  

					on their centrality in the sub-network. This centrality measures how  

					vital a protein is in maintaining or influencing connections within the  

					network.15  

					Figure 4: Top 10 Proteins predicted to interact with 12-  

					Methoxy-4-Methylvoachalotine (MMV) compound related to  

					cancer using the MCC method. The redder the resulting color,  

					the important the protein is in this network.  

					Likewise, Okpako et al.31 have reported the use of pharmacological  

					networks to predict the potential of secondary metabolites of the Aspilia  

					pluriseta plant as anticancer in prostate cancer. The results of this  
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					pharmacological network greatly assist subsequent analyses, such as  

					molecular docking. The pharmacological network method facilitates the  

					identification of potential protein targets. In contrast, the molecular  

					docking method can describe the extent of interaction between the test  

					compound and the selected target protein as its receptor.  

					Also, this study examined the effect of 12-methoxy-4-  

					methylvoachalotine (MMV) from Tabernaemontana catharinensis on  

					proteins involved in cancer mechanisms using the in silico method with  

					PLANTS, involving 38 proteins from http://rscb.org/. Validation was  

					carried out by redocking native ligands in YASARA, with the criteria  

					of Root Mean Squared Deviation (RMSD) <2.Å to ensure prediction  

					accuracy (Table 1). The process of removing water molecules was  

					carried out to reduce irrelevant interactions, and adding hydrogen aimed  

					to stabilize the ligand and increase binding affinity.32  

					Table 1: Validation results of the 5 most important proteins  

					PDB  

					Code  

					Native  

					Ligand  

					RMSD  

					score  

					Visualization of  

					validation results  

					Protein/Gene  

					Description  

					Estrogen Receptor Alpha ligand-binding  

					domain complexed to Estradiol.  

					ͦ

					1A52  

					1D5R  

					ESR1  

					EST  

					TLA  

					0.5319A  

					Crystal Structure of the PTEN Tumor  

					Suppressor  

					ͦ

					PTEN  

					1.0664A  

					Crystal Structure of EGFR T790M/V948R in  

					Complex with Covalent Pyrrolopyrimidine  

					14d  

					ͦ

					6TFU  

					5A7B  

					6NE5  

					EGFR  

					TP53  

					N7K  

					KMN  

					KJP  

					1.9491A  

					Structure of the p53 cancer Y220C bound to  

					the stabilizing small molecule PhiKan5211  

					ͦ

					1.9991A  

					Discovery of Potent Myeloid Cell Leukemia-  

					1 (Mcl-1) Inhibitors that Demonstrate in  

					vivo Activity in Mouse Xenograft Models of  

					Human Cancer  

					MCL1  

					1.7096 A  

					The molecular structure was made in 2D before conversion to 3D, with  

					protonation at pH 7.4 to reflect physiological conditions. Validation of  

					this native ligand is crucial because it can identify the optimal binding  

					position, which is expected to yield a small RMSD, thereby helping  

					predict the ligand’s biological activity and increasing the compound’s  

					potential as a drug.33 The molecular docking process of the MMV  

					compound against the validated target protein begins with ligand  

					preparation using MarvinSketch software version 5.2.5.1, where the  

					MMV molecule is drawn in the application (Figure 5). Table 2 shows  

					the docking results of MMV compounds with various receptors based  

					on PDB codes, including docking score values for MMV and native  

					ligands. The more negative the docking score, the more stable the  

					ligand-receptor interaction.34 If the docking score of the test compound  

					is more negative than that of the native ligand, then the test compound  

					shows better affinity. The greater stability of the interaction is positively  

					correlated with increased potential biological activity.35 Based on the  

					docking results on the 5 receptors, the affinity of MMV is lower than  

					that of the native ligand, but MMV still shows anticancer potential. In  

					docking results for the 1A52 receptor, the native ligand has a score of -  

					88.6142 kcal/mol, while MMV was only -76.2482 kcal/mol, indicating  

					its low anticancer potential. Likewise, in the 1D5R receptor, the native  

					ligand shows a score of -75.6527 kcal/mol, which is more stable than  

					the MMV of -60.0084 kcal/mol. In the 6TFU receptor, the native ligand  

					also shows a score of -111.678 kcal/mol, which is more stable than the  

					MMV of -72.2072 kcal/mol. Table 3 presents a visualization of amino  

					acid interactions between several target proteins and their native  

					ligands, and 12-Methoxy-4-Methylvoachalotine (MMV). In this  

					analysis, the similarity of amino acid interactions is essential for  

					understanding the binding mechanism and the potential anticancer  

					activity of MMV.  

					Table 2: Validation results of the 5 most important  

					Protein  

					PDB Code  

					Native Ligand  

					12-methoxy-4-  

					Methylvoachalotine  

					(MMV)  

					ESR1  

					PTEN  

					EGFR  

					TP53  

					1A52  

					1D5R  

					6TFU  

					5A7B  

					6NE5  

					-88.6142  

					-75.6527  

					-111.678  

					-133.823  

					-138.068  

					-76.2482  

					-60.0084  

					-72.2072  

					-85.8327  

					-80.9839  

					MCL1  

					5641  
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					Table 3: Visualization of the interaction of the molecular docking result of MMV and native ligand receptors ESR1, PTEN, EGFR,  

					TP53, and MGL1  

					No  

					Senyawa dan  

					Interaction Visualization (2D)  

					Ligand Interactions with  

					Amino Acids  

					Reseptor  

					1

					MMV-ESR1  

					(1A52)  

					ARG515,  

					ILE452,  

					SER450,  

					PHE445,  

					SER518,  

					MET517,  

					MET357,  

					ILE386,  

					LYS449,  

					GLU323,  

					ALA382,  

					AGA390,  

					GLU  

					385,  

					ILE389,  

					VAL446,  

					TRP383,  

					LEU387,  

					LEU384,  

					TRP360,  

					PRO324,  

					LEU391,  

					VAL392,  

					ILE514  

					Native ligand-  

					ESR1 (1A52)  

					ILE514,  

					SER518,  

					GLU385,  

					LEU387,  

					TRP383,  

					GLY390,  

					VAL446,  

					GLU323,  

					MET388,  

					LEU384,  

					ILE386,  

					ALA382,  

					ILE389,  

					ILE452,  

					PHE445,  

					LYS449,  

					LEU391,  

					MET357,  

					PRO324  

					2

					MMV-PTEN  

					(1D5R)  

					THR167,  

					VAL175,  

					VAL166,  

					GLY129,  

					HIS93,  

					PRO169,  

					LYS128,  

					VAL133,  

					PHE90,  

					ASN94,  

					ARG130,  

					PRO95,  

					ASP326,  

					ARG173,  

					HIS272,  

					ASP92,  

					SER170,  

					ILE168,  

					PRO96,  

					ARG172,  

					TYR174,  

					TRP274,  

					GLU91,  

					LEU98,  

					ILE101, TYR177  

					PRO169,  

					SER170,  

					ILE168,  

					PRO96,  

					ARG173  

					TYR174,  

					ARG172,  

					GLN171,  

					Native ligand-  

					reseptor PTEN  

					(1D5R)  

					VAL133, TRP274, PRO95,  

					HIS93,  

					ASN94,  

					PHE90,  

					ARG130  

					5642  
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					MMV-EGFR  

					(6TFU)  

					VAL834,  

					VAL851,  

					CYS775,  

					ASP837,  

					LEU798,  

					VAL843,  

					ARG841,  

					ILE853,  

					ILE821,  

					PHE856,  

					VAL774,  

					ASP855,  

					ILE853,  

					THR854,  

					HIS773,  

					ASN842,  

					ALA839,  

					LEU799,  

					HIS835,  

					THR903,  

					ARG836,  

					LEU907,  

					LEU833,  

					LYS852  

					ALA840,  

					LEU838,  

					GLU906,  

					MET825,  

					ASP896,  

					LEU844,  

					Native ligand -  

					EGFR (6TFU)  

					VAL845,  

					TRP880,  

					LEU844,  

					THR903,  

					VAL843,  

					GLU906,  

					LEU907,  

					ARG841,  

					CYS775,  

					ASP855,  

					LEU838,  

					ASP837,  

					PHE856,  

					LEU833,  

					VAL834,  

					MET825,  

					THR854,  

					VAL851,  

					LEU798,  

					CYS797,  

					ALA839,  

					VAL902,  

					ALA840,  

					LEU799,  

					ASN842,  

					LYS852,  

					HIS835,  

					GLY857,  

					HIS773,  

					VAL774,  

					ASP896,  

					GLY824,  

					GLU829,  

					ILE853  

					HIS214,  

					SER269,  

					ALA150,  

					VAL216,  

					LEU111,  

					ALA161,  

					LEU252  

					MET160,  

					ILE254,  

					LEU133,  

					ILE232,  

					ILE255,  

					4

					MMV-TP53  

					(5A7B)  

					PHE113, VAL197, ILE195,  

					LEU194,  

					VAL173,  

					THR253,  

					VAL272,  

					PHE270,  

					ARG196,  

					ILE251,  

					TYR236,  

					VAL143,  

					TYR234,  

					TYR126,  

					CYS141  

					SER215  

					5643  
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					Native ligand  

					- TP53  

					(5A7B)  

					VAL143,  

					LEU133,  

					ARG196,  

					TYR205,  

					HIS214,  

					PHE113,  

					ILE255,  

					TYR234,  

					HIS193,  

					VAL197,  

					ILE195,  

					SER215,  

					ALA159,  

					TYR236,  

					PHE270,  

					LEU111,  

					ALA161,  

					VAL216,  

					THR253,  

					TYR126,  

					SER269, ASN131, LYS132,  

					GLU204,  

					VAL217,  

					LEU194,  

					VAL272,  

					VAL274,  

					MET160,  

					ILE251,  

					GLU271,  

					ARG158,  

					MET246  

					5

					MMV-MCL1  

					(6NE5)  

					THR266,  

					ALA272,  

					THR295,  

					PHE270,  

					LEU290,  

					VAL265,  

					TYR185, SER269, PHE273,  

					LEU298, GLY271,  

					ALA291, ILE294, ILE268,  

					TRP261, ILE287,  

					LEU186, GLU288, SER183,  

					ARG187, ARG184,  

					SER178, ILE181, TRP312,  

					PHE315,  

					LEU213,  

					LEU267,  

					SER183  

					Native ligand  

					- MCL1  

					(6NE5)  

					LYS302,  

					TRP305,  

					PHE254,  

					LEU179,  

					LEU306,  

					ARG187,  

					ARG184,  

					THR295,  

					LEU298,  

					SER178,  

					ILE181,  

					ILE264,  

					VAL265, TRP212, TRP261,  

					PHE319,  

					PHE315,  

					GLU288,  

					GLU292, SER293, ALA291,  

					LEU290, PRO289, ILE294,  

					ALA275,  

					ALA272,  

					GLY271, LEU267, SER269,  

					LEU213,  

					GLN221,  

					PHE270,  

					PHE273,  

					VAL274,  

					GLY217,  

					THR266,  

					PHE228,  

					ILE268,  

					LEU186  

					as in Table 3). This similarity suggests that MMV can interact with the  

					same or similar active sites, potentially supporting anticancer activity.  

					However, despite the similarity, the binding affinity of MMV was lower  

					than that of the reference ligands. Other factors, such as the binding  

					strength and conformation of the MMV molecule, may influence this.  

					Therefore, to enhance MMV’s anticancer potential, structural  

					modifications that strengthen its interactions with target amino acids  

					should be considered. This approach is expected to enhance MMV’s  

					anticancer mechanisms.  

					Suppose the interaction between the test compound and the receptor’s  

					native ligand shows similarities; in that case, it is predicted that the test  

					compound can interact with the same or a similar active site as the  

					native ligand.36 Thus, the test compound has the potential to mimic or  

					replace the native ligand in its binding affinity as an anticancer.  

					However, if the interaction similarity is not significant, it may indicate  

					that the test compound does not effectively mimic the native ligand’s  

					biological activity.  

					In this study, the analysis showed that the amino acid interactions  

					formed between MMV and target proteins were mainly similar to those  

					involved in the binding of native ligands (amino acids marked in bold  

					The results of the absorption prediction search showed that the MMV  

					compound has a reasonably low water solubility of -2.95 (logmol/L).  

					However, absorption in the human intestine reaches 99.63%. The Caco-  
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					permeability of 1.198 (log Papp in 10⁶cm/s) indicates good  

					The excretion test results showed a total clearance of 0.804 (log  

					ml/min/kg), indicating moderate renal excretion, which can lead to  

					accumulation in the body if not appropriately excreted. The positive  

					status as an OCT2 substrate suggests that this compound is transported  

					by an organic transporter that affects the rate and efficiency of  

					excretion. These factors are essential for dose and potential toxicity. If  

					the compound is not excreted efficiently, its concentration can increase  

					and be dangerous, so understanding the excretion pathway helps design  

					a safe dose. Toxicity tests showed that this compound did not have  

					AMES toxicity, indicating safety against genetic mutations. However,  

					the maximum tolerated dose of -0.313 (log mg/kg/day) indicates  

					limitations at high doses. Acute oral toxicity (LD50) of 2.849 (mol/kg)  

					and chronic toxicity (LOAEL) of 1.871 (log mg/kg bw/day) indicate  

					potential toxic effects at high doses. Positive hepatotoxicity suggests an  

					impact on liver function and warrants further evaluation. Risk and  

					benefit assessment is vital before clinical therapy. More detailed  

					pharmacokinetic data of the MMV compound are shown in Table 4  

					below.  

					permeability through intestinal epithelial cells, while the skin  

					permeability of -2.907 (log Kp) indicates low efficiency in skin  

					penetration. The distribution of the compound was measured by the  

					volume of distribution (VDss) of 0.954 (log L/kg), indicating wide  

					distribution in body tissues, and an unbound fraction (Fu) of 0.219,  

					which increases the availability of pharmacologically active  

					compounds. However, the permeability at the blood-brain barrier  

					(BBB) of -0.186 (log BB) indicates difficulty in penetrating the barrier,  

					thus limiting the effect on the central nervous system. Overall, this  

					compound has high absorption potential in the digestive tract but  

					limited penetration into the central nervous system. Metabolism testing  

					results indicate that this compound is not a substrate for CYP2D6 or  

					CYP1A2, but is a substrate for CYP3A4, which may contribute to drug  

					interactions when given with other drugs metabolized by these  

					enzymes. Inactivity as an inhibitor of CYP2C19, CYP2C9, and  

					CYP2D6 suggests a low risk for interactions with other medications via  

					these pathways. These results indicate that, despite concerns about drug  

					interactions, the compound’s metabolic profile is well managed.  

					Table 4: Pharmacokinetic and toxicity profile of the compound of 12-methoxy-4-methylvoachalotine  

					Model Name  

					Absorption Properties  

					Prediction Value  

					Unite  

					Water solubility  

					-2.95  

					1.198  

					99.633  

					-2.907  

					No  

					(log mol/L)  

					(log Papp in 106 cm/s)  

					(% absorp)  

					Caco-2 permeability  

					Intestinal absorption (human)  

					Skin Permeability  

					(log Kp)  

					P-glycoprotein substrate  

					P-glycoprotein I inhibitor  

					P-glycoprotein II inhibitor  

					(Yes/No)  

					No  

					(Yes/No)  

					Yes  

					(Yes/No)  

					Distribution Properties  

					VDss(Human)  

					0.954  

					0.219  

					-0.186  

					-2.97  

					(logL/kg)  

					(Fu)  

					Fraction unbound (Human)  

					BBB permeability  

					CNS permeability  

					Metabolism Properties  

					CYP2D6 substrate  

					CYP3A4 substrate  

					CYP1A2 inhibitor  

					CYP2C19 inhibitor  

					CYP2C9 inhibitor  

					(log BB)  

					(log PS)  

					No  

					Yes  

					No  

					No  

					No  

					No  

					No  

					(Yes/No)  

					(Yes/No)  

					(Yes/No)  

					(Yes/No)  

					(Yes/No)  

					(Yes/No)  

					(Yes/No)  

					CYP2D6 inhibitor  

					CYP3A4 inhibitor  

					Excretion Properties  

					Total Clearance  

					0.804  

					Yes  

					(log ml/min/kg)  

					(Yes/No)  

					Renal OCT2 substrate  

					Toxicity Properties  

					AMES toxicity  

					No  

					-0.313  

					No  

					(Yes/No)  

					(log mg/kg/day)  

					(Yes/No)  

					Max. tolerated dose (human)  

					hERGIInhibitor  

					hERGII Inhibitor  

					Yes  

					(Yes/No)  

					Oral Rat Acute Toxicity  

					2.849  

					1.871  

					(mol/kg)  

					(LD )  

					50  

					Oral Rat Chronic Toxicity  

					(log mg/kg_bw/day)  

					5645  

					© 2025 the authors. This work is licensed under the Creative Commons Attribution 4.0 International License  

				

			

		

		
			
				
					
				
			

			
				
					Trop J Nat Prod Res, November 2025; 9(11): 5638 - 5647  

					ISSN 2616-0684 (Print)  

					ISSN 2616-0692 (Electronic)  

					https://doi.org/10.1038/nchembio.118.  

					Conclusion  
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					small molecules. Nucleic Acids Res. 2019;47(W1):W357-64.  
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					14. Shannon P. Cytoscape: a Software Environment for Integrated  
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					15. Chin CH, Chen SH, Wu HH, Ho CW, Ko MT, Lin CY. cytoHubba:  

					identifying hub objects and sub-networks from complex  

					interactome. BMC Syst. Biol. 2014;8(Suppl 4):S11., doi:  
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					This study successfully demonstrated the potential of 12-Methoxy-4-  

					Methylvoachalotine (MMV) as an anticancer agent through an in silico  

					approach. The pharmacological network successfully identified the key  

					targets of the MMV compound as an anticancer agent, including TP53,  

					PTEN, ESR1, EGFR, and MCL1. The receptor targets are related to the  

					mechanisms of cell growth and proliferation, regulation, and apoptosis.  

					Molecular docking results showed that MMV interacted with various  

					amino acids in the target protein’s active site, acting as a native ligand.  

					However, its affinity was comparable to that of the reference ligand. In  

					addition, the physicochemical properties of MMV showed low  

					solubility but good absorption, an essential aspect in drug development.  

					Therefore, further research is needed to implement structural  

					modifications to MMV to enhance anticancer activity and maximize its  

					therapeutic potential.  
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